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Lesson 6 ELECTROENCEPHALOGPAHY 2 Alpha Rhythms in the Occipital Lobe 

 
Fig. 6.1 

I. 

Electrical activity in the cerebral cortex is continuous from the 
formation of the cerebrum in utero to death. However, as the 
brain changes in size, shape, and function during its lifelong development, recognizable patterns of electrical activity 
displayed in an electroencephalogram also change. For example, EEGs recorded from the parieto-occipital regions of 
the brain of 3- to 4-month-old infants display waveforms with average frequencies of about 4 Hz; 12-month-old, 6 Hz; 
3-year-old, 8 Hz; 14-year old, 10 Hz. 

II. 

SCIENTIFIC PRINCIPLES 

As noted in EEG 1, the cerebrum, the largest part of the brain, is 
comprised of right and left hemispheres. Each hemisphere has 
an outer cerebral cortex (cortex = bark) divided into a frontal lobe, 
a parietal lobe, a temporal lobe, and an occipital lobe. Each lobe 
has unique functions (Fig. 6.1), but each lobe also shares 
functions with other lobes and other parts of the brain. 

Waveform amplitude and frequency also vary with the mental and physical state of the individual. The alpha rhythm, 
characterized by frequencies of 8–13 Hz and amplitudes of 20–200 µV, is the prominent EEG wave pattern of an 
adult in a relaxed, inattentive (not thinking about anything in particular) state, with eyes closed. Low frequency/larger 
amplitude alpha waves are dominant in forms of meditation associated with calm, lucid, mental states (the “alpha 
state”). 

Another condition that can alter the mean frequency and/or amplitude of the alpha rhythm is a change in the rate and 
depth of breathing. When a person hyperventilates (breathes rapidly and deeply), too much carbon dioxide is 
eliminated from the blood, causing the blood and the cerebrospinal fluid that bathes the brain to become too alkaline. 
These changes increase the overall electrical activity of the brain including the amplitude of alpha waves. 

Other determinants of alpha wave frequency and/or amplitude include: 

1. Gender: Females tend to have higher mean frequencies of alpha waves than males, although the differences 
are small. 

2. Memory: Frequency may affect the speed of “remembering” and may be approximately 1 Hz higher during 
memory tests for high-scoring subjects than for subjects who scored lower. 

3. Personality: Amplitudes tend to be higher in subjects who are extroverted. 

4. Mental stress: Amplitudes vary with the difficulty of mental tasks performed with eyes closed. 

5. Biorhythms: Amplitudes increase when subjects are less alert and tend to be higher from 1:30 pm–4:30 pm. 

6. Desynchronization: When the subject opens the eyes and becomes attentive to external stimuli, amplitudes 
diminish and frequency increases as the alpha rhythm is replaced by the beta rhythm. The “beta state” is 
associated with normal waking consciousness: attention directed toward the external environment. 

In this lesson, you will use electroencephalography to examine alpha rhythms in the occipital lobe. The software will 
filter the raw EEG signal to display alpha rhythm and alpha-RMS. 

EXPERIMENTAL OBJECTIVES 

1) To record an EEG from an awake, resting subject under the following conditions: 
a) relaxed with eyes closed; 
b) performing mental arithmetic with eyes closed; 
c) hyperventilating (breathing quickly and deeply) with eyes closed; and 
d) relaxed with eyes open. 

2) To examine differences in the level of alpha rhythm activity during mental arithmetic and hyperventilation, 
compared to the control condition of eyes closed and relaxed. 
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III. MATERIALS 

Computer system (running Windows XP or Mac OS X) 
Biopac Science Lab system (MP40 and software) 
Electrode lead set (40EL lead set) 
Disposable vinyl electrodes (EL503), three electrodes per subject 
Optional: Lycra® swim cap (such as Speedo® brand) or supportive wrap (such as 3M Coban™ self-adherent 
support wrap) to press electrodes against head for improved contact 
Cot or lab pillow 
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IV. EXPERIMENTAL METHODS 

A. Set Up 

EQUIPMENT 

 
Fig. 6.2 

SUBJECT 

RED Lead

BLACK Lead
(Ground)

WHITE Lead

 
Fig. 6.3 

 
FAST TRACK Details 

1. Turn the computer ON.  

2. Set the MP40 dial to  OFF.  

3. Attach three electrodes to the scalp as 
shown above. 

4. Connect the electrode leads (40EL) to the 
electrodes, matching lead color to electrode 
position as shown above. 

IMPORTANT 
Clip each electrode lead color to its 

specified electrode position. 

5. Recommended: To press electrodes against 
head for improved contact, affix a wrap or cap. 

Attach three electrodes to the subject as shown in Fig. 6.3: 
 4-5 cm behind top of ear (WHITE) 

 side of head, 4-5 cm above first electrode contact (RED) 

 ear lobe with adhesive folded under ear (BLACK) 

Note If it is easier, you can attach the BLACK lead 
(ground) to the neck instead of to the ear lobe 

 

 

6. Ask the Subject to completely relax, with eyes 
closed, for approximately five minutes before 
recording. 

7. Start the Biopac Science Lab software. 

Ideally, the room should be reasonably quiet to help the Subject 
mentally relax. A supine position with the head resting 
comfortably but tilted to one side is recommended. The best 
recordings occur when the Subject is relaxed throughout the 
session. 

8. Choose lesson L06-EEG-2 and click OK.  

9. Type in a unique file name. No two people can have the same file name, so use a unique 
identifier, such as the subject’s nickname or student ID#. 

10. Click OK. This ends the Set Up procedure. 

 



Lesson 6: EEG 2 Page 5 

B. Check 

FAST TRACK Details 

MP40 Check 

1. Set the MP40 dial to  EEG. 

2. Press and hold the  Check pad on the 
MP40. 

3. Click  when the light is flashing.  
 

4. Wait for the MP40 check to stop Continue to hold the pad down until prompted to let go. 

5. Let go of the  Check pad. 

6. Click Continue. 

The MP40 check procedure will last five seconds. 

The light should stop flashing when you let go of the Check 
pad. 

When the light stops flashing, click Continue. 

Signal Check  

7. Position the Subject. Position Subject and MP40 as far away from the computer as 
possible, and face Subject away from the monitor. 

Subject should be relaxed and still with eyes closed, and should 
remain in this state throughout Signal Check. Make sure the 
electrodes are making good contact with the scalp.  

 

The eight-second Signal Check recording should resemble Fig. 
6.4. 

8. Click Check Signal. 

9. Click OK and wait for the Signal Check to stop.

10. Review the data. 

 If correct, go to the Record section. 

 If incorrect, click . 

 
Fig. 6.4 

If the recording check did not show EEG spikes, redo the 
Check. 

© BIOPAC Systems, Inc. 2005 
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C. Record 

FAST TRACK Details 

1. Prepare for the recording and have the 
Subject lie down and relax with eyes closed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Recording continues… 

Watch the Help menu videos to prepare for the recording. You 
will record the Subject in four conditions; the Subject will 
perform tasks in the intervals between recordings. 

Segment 1: Relaxed with eyes closed 
Segment 2: Performing mental math with eyes closed 
Segment 3: Recovering from hyperventilation with eyes closed
Segment 4: Relaxed with eyes open 

For EEG recording with the MP40 System, it is especially 
important to position the Subject away from the computer 
monitor and to place the MP40 away from the computer (set 
aside or clip to subject). 

In order to work efficiently, read this entire section so you will 
know what to do for each recording segment. The Subject 
should remain in a supine position and continue to relax while 
you review the lesson. 

Tips for obtaining optimal data: 
a) Good electrode contact is essential to minimize noise 

and increase signal amplitude. 
b) The Subject should lie still and should not blink during 

the Eyes Open segment. Best results are obtained if the 
eyes remain still at all times. 

c) The Subject should not talk during any of the recording 
segments, and should not verbalize answers to the 
mental arithmetic. 

d) The alpha signal will be increased during the relaxation 
segment if the Subject concentrates on breathing slowly 
and/or relaxing muscles. 

e) For the Mental Arithmetic segment: the Director 
verbally provides a continuous arithmetic problem (e.g. 
2-4*3+9…) to Subject. Subject remains seated with eyes 
closed and silently solves this problem. 
The math problem should be challenging but not too 
difficult. The point is to make the Subject really work to 
get the answer, not to stump the Subject or make them 
give up. The math problem should require a minimum of 
20 seconds. 

f) Before the After Hyperventilation segment: the Subject
should breath quickly and deeply for two minutes, as if 
they had just finished exercising and needed air. The 
Subject should not be hyperventilating during the 
recording. 

Note During recording, the Input values 
window will appear on the right side 
of the graph window. The Input 
values window displays the alpha-
RMS value in a thermometer-like 
bar display and can be used as a 
visual aid to determine fluctuations 
in alpha-RMS activity. It is only 
displayed when data is recorded, 
and does not show in the Review 
Saved Data mode. 

 
Fig. 6.5 
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SEGMENT 1 — Eyes Closed  

2. Click Record and have the Subject continue 
to relax with eyes closed. 

When you click Record, the recording will begin and an append 
marker labeled Relaxed with eyes closed will automatically be 
inserted. 

 
3. Record for 10 seconds. Subject should be relaxed with eyes closed (seconds 0-10). 

4. Click Suspend. When you click Suspend, the recording will halt, giving you time 
to review the data and prepare for the next recording segment. 

5. Review the data. 

 If correct, go to Step 6. 

 If incorrect, click Redo. 

Your data should resemble Fig. 6.6. 

 
Fig. 6.6 Relaxed with eyes closed 

The data would be incorrect if: 

a) The Suspend button was pressed prematurely. 

b) An electrode peeled up causing a large baseline drift, 
spike, or loss of signal. 

c) The Subject did not follow the proper procedure. 

d) The Subject had too much EMG artifact. 

If data is incorrect, click Redo and repeat Steps 2-5; the last 
data segment you recorded will be erased. 

Segment 2 — Mental Arithmetic  

6. Director prepares a mental arithmetic problem 
while Subject remains relaxed with eyes 
closed. 

Director prepares the arithmetic problem (see Tips in Step 1). 

Subject remains relaxed with eyes closed. 

7. Click Resume. When you click Resume, the recording will continue and an 
append marker labeled Mental arithmetic will be automatically 
inserted. 

8. Director gives Subject a mental math 
problem. 

Director verbally provides a continuous arithmetic problem (e.g. 
2-4*3+9 ...) to Subject. 
Subject remains seated with eyes closed and silently solves this 
problem. 

Subject should perform mental arithmetic as posed by the 
Director and keep eyes closed. 

9. Record for 20 seconds. Subject is performing mental math (seconds 11-30). 

10. Click Suspend. 

 

Recording continues… 

When you click Suspend, the recording will halt, giving you time 
to review the data and prepare for the next recording segment. 
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11. Review the data. 

 If correct, go to Step 12. 

 If incorrect, click Redo. 

Your data should resemble Fig. 6.7. 

 
Fig. 6.7 Mental arithmetic 

The data would be incorrect for the reasons listed in Step 5. 

If data is incorrect, click Redo and repeat Steps 6-11; the last 
data segment you recorded will be erased. 

Segment 3 — After Hyperventilation  

12. Director advises Subject to hyperventilate for 
two minutes. 

WARNING 
Hyperventilation can make the Subject 

dizzy and light headed. The Subject should 
be sitting down, and the Director should be 
watching. Stop the procedure if the Subject 

starts to feel sick or dizzy. 

Director advises Subject to hyperventilate (see Tips in Step 1). 

Subject should hyperventilate for two minutes with eyes closed.

It is important that you resume recording as quickly as possible 
after the Subject has hyperventilated. However, it is also 
important that you do not click Resume while the Subject is 
hyperventilating or you will capture EMG artifact. 

13. Click Resume. When you click Resume, the recording will continue and an 
append marker labeled After hyperventilation will be 
automatically inserted. 

14. Record for 10 seconds while Subject is 
recovering from hyperventilation. 

Subject should be in a relaxed state with eyes closed, 
recovering from hyperventilation (seconds 31-40). 

15. Click Suspend. When you click Suspend, the recording will halt, giving you time 
to prepare for the next recording segment. 

16. Review the data. 

 If correct, go to Step 17. 

 If incorrect, click Redo. 

 

 

 

 

 

 

 

 

Recording continues… 

Your data should resemble Fig. 6.8. 

 
Fig. 6.8 Recovering from hyperventilation, eyes closed 
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 The data would be incorrect for the reasons listed in Step 5. 

Note It is normal to have some baseline drift after 
hyperventilation, as shown in Fig. 6.8. 

If data is incorrect, click Redo and repeat Steps 12-16; the last 
data segment you recorded will be erased. 

Segment 4 — Eyes Open  

17. Director advises Subject to open the eyes 
and continue to relax. 

Director should advise Subject to open the eyes and remain 
relaxed. 

18. Click Resume. When you click Resume, the recording will continue and an 
append marker labeled Eyes open will be automatically 
inserted. 

19. Record for 10 seconds. Subject should be in a relaxed state with eyes open and try to 
not blink (seconds 41-50). 

20. Click Suspend. When you click Suspend, the recording should halt. 

21. Review the data. 

 If correct, go to Step 22. 

 If incorrect, click Redo. 

Your data should resemble Fig. 6.9. 

 
Fig. 6.9 Relaxed, eyes open 

The data would be incorrect for the reasons in Step 5. 

If data is incorrect, click Redo and repeat Steps 17-21; the last 
data segment you recorded will be erased. 

22. Optional: Click Resume to record additional 
segments. 

Optional: You can record additional segments by clicking 
Resume instead of Done. A time marker will be inserted at the 
start of each added segment. 

23. Click Done. 

24. Click Yes. 

25. Choose an option and click OK. 

A pop-up window with options will appear. Click Yes (or No if 
you want to redo the last segment). 

When you click Yes, a dialog with options will be generated. 
Make your choice, and click OK. 

 If you choose Analyze current data file, go to the 
Analyze section for directions. 

26. Remove the electrodes. 

END OF RECORDING 

Disconnect the lead clips and peel off the electrodes. 

© BIOPAC Systems, Inc. 2005 
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V. ANALYZE 

FAST TRACK Details 

1. Enter the Review Saved Data mode and 
choose the correct file. 

To review saved data, choose Analyze current data file from 
the Done dialog after recording data, or choose Review Saved 
Data from the Lessons menu and browse to the required file.  

Note Channel Number(CH) designations: 

Channel Displays 

CH1 EEG 

CH40 Alpha 

CH41 Alpha RMS 

The data window should come up the same as Fig. 6.10. 

 
Fig 6.10 

2. Set up your display window for optimal viewing 
of the entire recording. 

The following tools help you adjust the data window:  
Autoscale Horizontal Horizontal (Time) Scroll Bar 
Autoscale Waveforms Vertical (Amplitude) Scroll Bar 
Zoom Zoom Previous/Back 

Show or Hide Grids by choosing File > Display Preferences. 

3. Set up the measurement boxes as follows: 

Channel Measurement 

CH1 Stddev 

CH40 Stddev 

CH41 Mean 

CH40 Freq 

 

 

 

 

 

 

 

 

 

 

 

 

 

Analysis continues… 

The measurement boxes are above the marker region in the 
data window. Each measurement has three sections: channel 
number, measurement type, and result. The first two sections 
are pull-down menus that are activated when you click them. 
The following is a brief definition of specific measurements:  

Stddev: standard deviation will be higher if there is a lot of 
activity and lower if there is less. The advantage of the stddev 
measurement is that extreme values or artifacts do not unduly 
influence the measurement. 
Mean: displays the average value in the selected area. 
Freq: converts the time segment of the selected area to 
frequency in cycles per second 

Note The Freq measurement applies to all channels since 
it is calculated from the horizontal time scale. 

Note The “selected area” is the area selected by the I-
beam tool (including the endpoints). 
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4. Using the I-Beam cursor, select the first data 
segment. 

 A 

Fig. 6.11 shows an example of the selected area. The first data 
segment begins at the first append marker labeled Relaxed 
with eyes closed. 

 
Fig. 6.11 

5. Repeat the above measurements for each of 
the data segments. 

 A 

 

6. Zoom in on a small section of the Segment 1 
data. 

Be sure to zoom in far enough so that you can easily measure 
the frequency of the alpha wave. 

7. Using the I-Beam cursor, select an area from 
one peak to the next in the alpha band (CH 40).

 B 

Fig. 6.12 shows a sample setup for measuring the frequency in 
the alpha band (CH 40). 

 
Fig. 6.12 

8. Save or print the data file. You may save the data, save notes that are in the journal, or 
print the data file. 

9. Exit the program. 

10. Set the dial to  Off. 

 

END OF DATA ANALYSIS 

 

  
END OF LESSON 6 

Complete the Lesson 6 Data Report that follows. 
  

© BIOPAC Systems, Inc. 2005 
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The Data Report starts on the next page. 
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These are sample questions. You should 
amend, add, or delete questions to 
support your curriculum objectives. 

Lesson 6 ELECTROENCEPHALOGRAPHY II 
Alpha Rhythms in the Occipital Lobe 

 
DATA REPORT 

Student’s Name:   

Lab Section:   

Date:   
 
I. Data and Calculations 
Subject Profile 
Name  Age  
Gender:   Male   /   Female Height  

 Weight  

EEG Amplitudes 
A. Complete Table 6.1 with the amplitudes of the recorded data in the control and experimental conditions 

Table 6.1 Amplitude results 
Segmen

t Experimental Condition EEG 
[1-Stddev] 

Alpha 
[40-Stddev] 

Alpha-RMS 
[41-Mean] 

1 Eyes Closed (control)    
2 Eyes Closed, Mental Arithmetic    
3 Eyes Closed, After Hyperventilation    

4 Eyes Open    

EEG Frequencies 

B. What is the frequency of an alpha rhythm from Segment 1 data? Hz 

Does this agree with the expected values?     Yes     No 
 
C. Complete Table 6.2 with the mean values of the Alpha RMS channel (CH41) from Table 6.1. 

The “Control Mean” is the mean Alpha RMS from Segment 1. You will need to calculate the difference between 
the Experimental Mean and the Control Mean. Summarize whether the Experimental Mean was larger (+), 
smaller (−), or the same (=) as the Control Mean. 

Table 6.2 

Segment Experimental 
Condition 

Experimental 
Mean 

Control Mean
(Seg 1) 

Calculate the 
Difference 

(Exp. - Control) 

Summary 
(+, −, =) 

2 Mental Arithmetic     
3 After Hyperventilation     
4 Eyes Open     

 
II. Questions 
D. Refer to Table 6.1: When was the general amplitude of the EEG highest? 

  

  

  

© BIOPAC Systems, Inc. 2005 
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E. Refer to Table 6.1: When were the alpha wave levels highest? 

  

  

  

  

F. Refer to Table 6.1: How do your results compare with the information presented in Section 1 (Scientific 
Principles)? 

  

  

  

  

G. Did the Subject need to concentrate during math problems?     Yes     No 
How would the level of concentration required affect the data? 

  

  

  

  

H. What might account for the amplitude difference of waves recorded from a subject tested alone in a 
darkened room, and subjects tested in a lab full of students? 

  

  

  

I. Which conditions produced the lowest alpha activity? 

  

  

  
 

End of Biopac Science Lab Lesson 6 Data Report 
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VI. ACTIVE LEARNING LAB 

Design a new experiment to test or verify the scientific 
principle(s) you learned in the Biopac Science Lab recording 
and analysis segments. 

 For this lesson, you might examine how gender, 
memory, personality, mental stress, biorhythms, and 
desynchronization influence alpha wave frequency and/or 
amplitude. 

Design Your Experiment 

Use a separate sheet to detail your experiment design, and be 
sure to address these main points: 

A. Hypothesis 

Describe the scientific principle to be tested or verified. 

B. Materials 

List the materials will you use to complete your investigation.

C. Method 

Describe the experimental procedure—be sure to number 
each step to make it easy to follow during recording. 

 See the Set Up section or Help > About Electrodes for 
electrode placement guidelines. 

Run Your Experiment 

D. Setup 

Set up the equipment and prepare the subject for your 
experiment. 

E. Recording 

Use the Record, Resume, and Suspend buttons in the 
Biopac Science Lab program to record as many segments 
as necessary for your experiment. 

Click Done when you have completed all of the segments 
required for your experiment. 

Analyze Your Experiment 

F. Set measurements relevant to your experiment and record 
the results in a Data Report. 
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